Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©November 2005

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.

AMD Athlon™ is a trademark of Advanced Micro Devices, Inc
SRS WOW is a trademark of SRS Labs, Inc.
WOW technology is incorporated under license from SRS Labs, Inc.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 11A minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class I Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don't drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

<table>
<thead>
<tr>
<th>Do not expose the computer to any shock or vibration.</th>
<th>Do not place it on an unstable surface.</th>
<th>Do not place anything heavy on the computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
</tr>
</tbody>
</table>

2. **Keep it dry, and don't overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

<table>
<thead>
<tr>
<th>Do not expose it to excessive heat or direct sunlight.</th>
<th>Do not leave it in a place where foreign matter or moisture may affect the system.</th>
<th>Don’t use or store the computer in a humid environment.</th>
<th>Do not place the computer on any surface that will block the vents.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
</tr>
</tbody>
</table>
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

   - Do not turn off the power until you properly shut down all programs.
   - Do not turn off any peripheral devices when the computer is on.
   - Do not disassemble the computer by yourself.
   - Perform routine maintenance on your computer.

5. **Take care when using peripheral devices.**

   - Use only approved brands of peripherals.
   - Unplug the power cord before attaching peripheral devices.
Preface

Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Do not plug in the power cord if you are wet.  
Do not use the power cord if it is broken.  
Do not place heavy objects on the power cord.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it's latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag's straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
Preface

**On the Road**

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.
Contents

Notice ................................................................. I
FCC Statement .................................................. II
Instructions for Care and Operation ............... IV
Power Safety ...................................................... VI
Battery Precautions ......................................... VII
Cleaning ......................................................... VIII
Servicing ......................................................... VIII
Travel Considerations ...................................... IX

Quick Start Guide
Overview ......................................................... 1-1
Advanced Users ................................................ 1-2
Beginners and Not-So-Advanced Users .......... 1-2
Warning Boxes ................................................... 1-2
Not Included ...................................................... 1-2
System Software ............................................... 1-3
System Startup ................................................... 1-4
System Map: Top View with LCD Panel Open .... 1-5
LED Indicators ................................................... 1-6
AP-Key Buttons .................................................. 1-7
Function Keys & Numeric Keypad ................. 1-7
System Map: Front & Rear Views ................. 1-9
System Map: Left View ................................. 1-10
System Map: Right View ................................. 1-11
System Map: Bottom View ......................... 1-12
Windows XP Start Menu & Control Panel .... 1-13
Video Features ............................................... 1-14
Display Devices & Options ......................... 1-14
Power Management Features ....................... 1-16

Storage Devices, Mouse, Audio & Printer
Overview ......................................................... 2-1
Hard Disk Drive ............................................... 2-2
Optical Device ............................................... 2-3
Loading Discs .................................................. 2-3
Handling CDs or DVDs ................................. 2-4
DVD Regional Codes ................................. 2-5
10-in-1 Card Reader ................................. 2-6
PC Card Slot ................................................... 2-7
Inserting and Removing PC Cards ................. 2-7
TouchPad and Buttons/Mouse ................... 2-8
Configuring the Infrared Settings for FIR .... 2-9
Audio Features ............................................... 2-10
8 Channel Sound Support ......................... 2-11
Audio "DJ" CD Player ................................. 2-12
**Preface**

- Adding a Printer ..................................................... 2-14
- USB Printer .......................................................... 2-14
- Install Instructions: .............................................. 2-14
- Parallel Printer ...................................................... 2-14

**Power Management**

- Overview .............................................................. 3-1
- Advanced Configuration and Power Interface ........ 3-1
- The Power Sources ............................................... 3-2
- AC/DC Adapter .................................................... 3-2
- Battery ............................................................... 3-2
- Turning on the Computer ...................................... 3-3
- Power Schemes .................................................... 3-4
- System Power Options ......................................... 3-6
- Hibernate Mode vs. Shutdown ............................... 3-6
- Stand by Mode vs. Hibernate Mode ......................... 3-6
- Stand by ........................................................... 3-7
- Hibernate .......................................................... 3-7
- Configuring the Power Button ............................... 3-8
- Battery Information .............................................. 3-9
- New Battery ...................................................... 3-9
- Battery Life ........................................................ 3-9
- Recharging the Battery with the AC/DC Adapter .... 3-10
- Proper handling of the Battery Pack ....................... 3-11
- Battery FAQ ...................................................... 3-12

**Drivers & Utilities**

- System Software Installation with RAID Option ...... 4-1
- What to Install ..................................................... 4-2
- Module Driver Installation ................................... 4-2
- Service Packs ..................................................... 4-4
- Authorized Driver Message ................................... 4-5
- Version Conflict Message ..................................... 4-5
- Updating/Reinstalling Individual Drivers ............... 4-5
- Driver Installation ............................................... 4-6
- Manual Driver Installation ................................... 4-7
- Windows XP ......................................................... 4-8
- Driver Installation Procedure ............................... 4-8
- New Hardware Found ......................................... 4-8
- Chipset ............................................................. 4-9
- RAID ................................................................. 4-9
- AMD Processor .................................................. 4-10
- Video (VGA) ....................................................... 4-10
- Audio ............................................................... 4-10
- Modem .............................................................. 4-11
- LAN ................................................................. 4-11
- AP-Key Buttons .................................................. 4-12
- TouchPad ........................................................... 4-12
- Module Drivers .................................................. 4-13
- Wireless LAN .................................................... 4-13
BIOS Utilities
Overview .......................................................... 5-1
The Power-On Self Test (POST) ............................. 5-2
  Failing the POST .................................................... 5-3
    Fatal Errors ....................................................... 5-3
    Non-Fatal Errors ................................................ 5-3
The Setup Program ................................................... 5-4
  Entering Setup ........................................................ 5-4
  Setup Screens ......................................................... 5-5
Main Menu ............................................................... 5-6
  System Time & Date (Main Menu) ......................... 5-6
  IDE Channel 0/1/2/3 Master/Slave (Main Menu) .... 5-7
  System/Extended Memory: (Main Menu) ............... 5-7
  Advanced Menu ....................................................... 5-8
    Advanced Chipset Control (Advanced Menu) ...... 5-8
    I/O Device Configuration (Advanced Menu) ...... 5-10
    Reset Configuration Data (Advanced Menu) ...... 5-11
    Boot Diagnostic Screen: (Advanced Menu) ...... 5-11
    Power On Boot Beep (Advanced Menu) .......... 5-11
    Security Menu .................................................. 5-12
  Set Supervisor Password (Security Menu) ............ 5-12
Password on boot: (Security Menu) ....................... 5-13
Boot Menu ............................................................ 5-14
Exit Menu ............................................................ 5-15

Upgrading The Computer
Overview ............................................................ 6-1
  When Not to Upgrade ............................................ 6-2
  Removing the Battery ........................................... 6-3
  Upgrading the Hard Disk Drive(s) ....................... 6-4
  Upgrading the System Memory (RAM) ................. 6-6
  Upgrading the Optical (CD/DVD) Device(s) ........ 6-8

Modules
Overview ............................................................. 7-1
  The Wireless LAN & Bluetooth Modules ............... 7-2
    Mini-PCI Wireless LAN Module ......................... 7-3
      Intel WLAN Driver Installation .................... 7-4
      Ralink 6833 WLAN Driver Installation ............ 7-5
    Bluetooth/WLAN Combo Module ....................... 7-7
      MSI 6855B WLAN Driver Installation ............... 7-8
    Bluetooth Module .............................................. 7-11
      Bluetooth Driver Installation ...................... 7-11
    Mini-PCI TV Tuner Module ............................... 7-13
      Installing the AverTV Utility Software .......... 7-14
      Installing the Cyberlink PowerDVD 6 Software 7-14
Preface

Digital TV Broadcast Signal ...................... 7-15
PC Camera ............................................. 7-16
PC Camera Driver Installation ..................... 7-16
PC Camera Audio Setup .............................. 7-17
EMAMCAP ............................................. 7-19
RAID Setup ........................................... 7-21
RAID Mode Setup .................................... 7-22

Troubleshooting
Overview ............................................. 8-1
Basic Hints and Tips ............................... 8-2
Backup and General Maintenance ............... 8-3
Viruses ................................................. 8-4
Upgrading and Adding New Hardware/Software ... 8-5
Problems & Possible Solutions ................. 8-7

Interface (Ports & Jacks)
Overview ........................................... A-1
Ports and Jacks ...................................... A-2
Built-In Microphone ............................... A-2
DC-In Jack .......................................... A-2
Serial Port .......................................... A-2
Parallel Port ........................................ A-2
DVI-Out Port ....................................... A-2
PS/2 Port ............................................. A-2
RJ-11 Phone Jack ................................. A-3
RJ-45 LAN Jack ................................... A-3
CATV-In Jack ...................................... A-3
S-Video-In Jack ................................... A-3
S-Video-Out Jack .................................. A-3
USB 2.0/1.1 Ports .................................. A-3
Mini-IEEE 1394a Ports ......................... A-4
Line-In Jack ........................................ A-4
S/PDIF-Out Jack ................................. A-4
Microphone-In Jack .............................. A-4
Headphone-Out Jack ............................. A-4
Security Lock Slot ............................... A-4

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ........... B-1
NVIDIA Display Properties .................... B-2
Additional Properties ........................... B-3
NVIDIA nView Desktop Manager .......... B-5
Display Devices .................................. B-6
Attaching Other Displays ....................... B-7
Display Modes .................................... B-9
Enabling TV Display ............................ B-10
## Specifications

- **Processor Types** ....................................................... C-2
- **Core Logic** ............................................................... C-2
- **LCD** ................................................................. C-2
- **Security** .............................................................. C-2
- **Memory** ............................................................... C-3
- **BIOS** ................................................................. C-3
- **Video Card Options** ................................................. C-3
- **Storage Options** ..................................................... C-4
- **Audio** ................................................................. C-4
- **Keyboard & Pointing Device** .................................... C-4
- **PCMCIA** ............................................................... C-4
- **I/O Ports** ............................................................... C-5
- **Communication** ..................................................... C-5
- **Card Reader** .......................................................... C-5
- **Power Management** ................................................ C-6
- **Power** ................................................................. C-6
- **Environmental Spec** ................................................ C-6
- **Physical Dimensions & Weight** ............................. C-6
- **Optional** ............................................................. C-6
Preface
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• **Chapter 2**  The Storage Devices (hard disk, optical device, 10-in-1 Card Reader, PC Card), Mouse, Audio & Printer.
• **Chapter 3**  The computer’s **power** saving options.
• **Chapter 4**  The installation of the **drivers** and utilities essential to the operation or improvement of some of the computer’s subsystems.
• **Chapter 5**  An outline of the computer’s built-in software, or **BIOS** (Basic Input Output System).
• **Chapter 6**  Instructions for **upgrading** your computer.
• **Chapter 7**  A quick guide to the computer’s **TV Tuner**, **wireless**, **Bluetooth**, **camera** modules (some of which may be **optional** depending on your purchase configuration).
• **Chapter 8**  A **troubleshooting** guide.
• **Appendix A**  A definition of the **interface**, **ports/jacks** which allow your computer communicate with external devices.
• **Appendix B**  Information on the **NVIDIA** Video driver controls.
• **Appendix C**  The computer’s **specification**.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a  as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the  symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows XP etc.) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find this manual refers to the following operating systems:

- Microsoft Windows XP Home & Professional Editions
- Microsoft Windows XP Media Center Edition 2005

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 7. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “What to Install” on page 4 - 2 for installation instructions.
System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Move and hold the LCD latches in the direction of the arrows to release the top cover.
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
7. Adjust the LCD panel to a comfortable viewing angle.
8. The LED indicators show the power and battery status of the computer.

Figure 1 - 1 - Top Panel with LCD Closed

Shutdown

Please note that you should always shut your computer down by choosing the **Shut Down/Turn Off Computer** command from the **Start** menu in **Windows**. This will help prevent hard disk or system problems.
System Map: Top View with LCD Panel Open

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

The key combination Fn + F11 toggles power to the WLAN module, Fn + F12 to the Bluetooth module.

1. Optional Built-In PC Camera
2. LCD
3. LED Power & Communication Indicators
4. Speakers
5. LED Status Indicators
6. Built-In Microphone
7. AP-Key Buttons
8. Power Button
9. Lid Sensor (not visible externally - see page 3 - 8)
10. Keyboard
11. TouchPad and Buttons

Figure 1 - 2 - Top View with LCD Panel Open
LED Indicators
The two sets of LED indicators (LED Status Indicators and LED Power & Communication Indicators) on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>Green</td>
<td>Card Reader Activity</td>
</tr>
<tr>
<td>🚀</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>🛠</td>
<td>Green</td>
<td>Number Lock Activated</td>
</tr>
<tr>
<td>🕵️</td>
<td>Green</td>
<td>Caps Lock Activated</td>
</tr>
<tr>
<td>🔻</td>
<td>Green</td>
<td>Scroll Lock Activated (to activate press Fn &amp; Scr Lk)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>💻</td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
</tr>
<tr>
<td>🟠</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>🟠</td>
<td>Blinking Green</td>
<td>The Computer is in Stand by Mode</td>
</tr>
<tr>
<td>🟠</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>✅</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>🟠</td>
<td>Blinking Orange</td>
<td>The Battery Has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>🌐</td>
<td>Green</td>
<td>The (optional) Wireless LAN Module is powered On</td>
</tr>
<tr>
<td>🔴</td>
<td>Orange</td>
<td>The (optional) Bluetooth Module is powered On</td>
</tr>
</tbody>
</table>
AP-Key Buttons
These buttons access the internet, e-mail or a user-defined application with one quick button press. Make sure you install the driver to enable the AP-Key Button functions (refer to “What to Install” on page 4-2).

Table 1-3 - AP-Key Buttons

<table>
<thead>
<tr>
<th>Ap-Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌈</td>
<td>Activate the Default E-mail Program</td>
</tr>
<tr>
<td>🌧️</td>
<td>Activate the Default Internet Browser</td>
</tr>
<tr>
<td>🌧️</td>
<td>Activate a User Specified Application (Default is Windows Media Player)</td>
</tr>
</tbody>
</table>

The AP-Key driver icon 🌈 will appear in the taskbar after the driver is installed. Right-Click the icon and browse to Setup > Application 1, and an open dialog box will appear. Select an application (e.g. Microsoft Word) to open when you press the Application AP-Key Button (make sure you select the .exe file, and not a shortcut to it).

Function Keys & Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data input (see Figure 1-3).

Activate the Number Lock feature by pressing the Num Lk key at the top right of the keyboard. You may check if Number Lock is enabled or not by looking at the LED status indicators.

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/AP-Key buttons unique to the system’s regular keyboard may not work.
### Table 1 - 4 - Function Keys

<table>
<thead>
<tr>
<th>Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn</td>
<td>Function Key</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
</tr>
<tr>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>WLAN Module Toggle</td>
</tr>
<tr>
<td>Fn + F12</td>
<td>Bluetooth Module Toggle</td>
</tr>
<tr>
<td>Fn + Scr Lk</td>
<td>Scroll Lock Toggle</td>
</tr>
</tbody>
</table>

### Figure 1 - 3 - Keyboard

#### Special Characters

Some software applications allow the number-keys to be used with **Alt** to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that **Num Lk** is on.
System Map: Front & Rear Views

Audio "DJ" Player
The built-in standalone audio CD player gives you direct hardware control for audio CDs (MP3 compatible) when the computer is shut down, but has a working power source.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Quick Start Guide

Figure 1 - 4
Front & Rear Views
1. LCD Latches
2. Audio "DJ" Player Controls
3. Consumer Infrared Transceiver*
4. Speakers
5. Vent/Fan Intake
6. DC-In Jack
7. Serial Port
8. Parallel Port
9. DVI-Out Port
10. PS2 Port
11. RJ-11 Phone Jack
12. RJ-45 LAN Jack
13. CATV Jack*
14. S-Video-In Jack*

*Enabled with Optional Mini-PCI TV Tuner Only
Quick Start Guide

System Map: Left View

Figure 1 - 5
Left View
1. S-Video-Out Jack
2. 4 * USB 2.0 Ports
3. 2 * Mini-IEEE 1394a Port
4. Line-In Jack
5. S/PDIF-Out Jack
6. Microphone-In Jack
7. Headphone-Out Jack
8. 10-in-1 Card Reader
9. PC Card Slot
10. Infrared Transceiver
(see page 2 - 9)

10-in-1 Card Reader Formats
The card reader allows you to use the most popular digital storage card formats:

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS (Memory Stick Pro)
- SM (SmartMedia Card)
- CF (Compact Flash)
- IBM Microdrive
- MS Duo (requires PC adapter)
- Mini SD (requires PC adapter)
- RS MMC (requires PC adapter)

Note: If you are installing an operating system (e.g. Windows XP) you will need to disable the card reader in the BIOS (see “Card Reader: (Advanced Menu > Advanced Chipset Control)” on page 5 - 10).
System Map: Right View

1. Primary Optical Device Drive Bay (for CD/DVD Device)
2. Secondary Optical Device Drive Bay (for CD/DVD Device)
3. Security Lock Slot

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or similar object that may break and become lodged in the hole.

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Figure 1 - 6 - Right View
**System Map: Bottom View**

*Figure 1 - 7 - Bottom View*

1. Battery
2. Vent/Fan Intake
3. Memory (RAM) Cover
4. Hard Disk Cover
5. Sub Woofer
6. Video Card Cover
7. CPU Cover

---

**Battery Information**

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instructions.
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within *Windows XP* are accessed from the *Start* menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the *Start* menu and/or the desktop. You can customize the look of the *Start* menu by right-clicking the *Start* menu and selecting *Properties* from the menu.

In many instances throughout this manual you will see an instruction to open the *Control Panel*. The *Control Panel* is accessed from the *Start* menu. The *Control Panel* allows you to configure the settings for most of the key features in *Windows* (e.g. power, video, network, audio etc.). *Windows XP* provides basic control panels for many of the features, however many new control panels are added (or existing ones are enhanced) when you install the drivers listed in *Table 4 - 1, on page 4 - 7*. To see all controls it may be necessary to toggle off *Category View*. 
Video Features

This computer features different PCI Express video card options (see “Video Card Options” on page C - 3). You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on page B - 1.

To access Display Properties in Windows:

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen area/resolution 1 (Figure 1 - 9 on page 1 - 15).
5. Click the arrow, and scroll to the preferred setting In Colors/Color quality 2 (Figure 1 - 9 on page 1 - 15).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) 3 (Figure 1 - 9 on page 1 - 15) to bring up the Advanced properties tabs.
8. Clicking the tabs or Additional Properties allows you to make any video adjustments you require.

Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV as your display device. A VGA monitor/Flat Panel Display connects to the DVI-Out port, a TV to the S-Video-Out jack. See Table 1 - 5, on page 1 - 15 for a summary of the display modes available, and see “NVIDIA Video Driver Controls” on page B - 1 for details.
**Quick Start Guide**

**Figure 1 - 9 - Display Properties Desktop**

<table>
<thead>
<tr>
<th>NVIDIA Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Clone</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Dualview</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

**Table 1 - 5 - Display Options**
Quick Start Guide

Power Management Features

The **Power Options** control panel in *Windows* (see page 1 - 13) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk (by means of **Power Schemes**), or you may use either **Stand by** or **Hibernate** mode to conserve power throughout the system (enable **Hibernate** support from the control panel as pictured in Figure 1 - 10). Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

![Power Options](image)

**Figure 1 - 10 - Power Options**

The computer’s **power button**, **sleep button** (Fn + F4 key combination), and **Lid Sensor** may be set to send the computer in to either **Stand by** or **Hibernate** mode.

Power Saving and Performance

Power Schemes may have an affect on your computer performance (see “**Power Schemes**” on page 3 - 4).
Chapter 2: Storage Devices, Mouse, Audio & Printer

Overview
Read this chapter to learn more about the following main features and components of the computer:

• Hard Disk Drive
• Optical Device
• 10-in-1 Card Reader
• PC Card Slot
• TouchPad and Buttons/Mouse
• Configuring the Infrared Settings for FIR
• Audio Features
• Audio "DJ" CD Player
• Adding a Printer
Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5" hard disk drives with a height of 9.5 mm. The hard disk 1 is accessible from the bottom of your computer as seen below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 4.

The computer supports both serial (SATA) and parallel (PATA) hard disks. Make sure you use the appropriate cable 2 for the particular hard disk(s) you use. Only serial (SATA) hard disks support a RAID configuration.

Power Safety

Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.

Figure 2 - 1
Hard Disk Location
**Optical Device**

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage Options” on page C - 4). The optical device is usually labeled “Drive D:" and may be used as a boot device if properly set in the BIOS (“Boot Menu” on page 5 - 14).

**Loading Discs**

To insert a CD/DVD, press the open button ① and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator ② will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole ③ to open the tray.

**Sound Volume Adjustment**

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting.

Peripherals must be connected before you turn on the system.

*Figure 2 - 2  Optical Device*
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.
DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 11.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>
Storage Devices, Mouse, Audio & Printer

10-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS (Memory Stick Pro)
- SM (SmartMedia Card)
- CF (Compact Flash Types I & II)
- MD (IBM Microdrive)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.

Figure 2 - 4
Removable Disks

The cards will appear as removable disks on the computer and can be accessed in the same way as your hard disk(s).
PC Card Slot

The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC Card.

Inserting and Removing PC Cards

- Align the PC Card with the slot and push it in until it locks into place.
- To remove a PC Card, simply press the eject button next to the slot.

*Figure 2 - 5*  
PC Card Slot
TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse. The central button may be configured to function as you require.

Once you have installed the TouchPad driver (see page 4 - 12) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information on this at www.synaptics.com.

Figure 2 - 6
Mouse Properties
Configuring the Infrared Settings for FIR

To configure your computer for Fast Infrared (FIR) communication follow these steps:

1. Click **Start**, point to **Settings** and click **Control Panel** (or just click **Start > Control Panel**).
2. Double-click **Wireless Link** (Printers and Other Hardware Category) icon.
3. Click **Hardware** (tab), and click the **Properties** button, then click the **Advanced** (tab).
4. Select “Infrared Transceiver A” and change the **Value** to “HP HSDL-2300/3600”.
5. Click **OK > OK**.
6. Restart the computer if prompted to do so.

You can change the infrared transceiver mode (serial port B) from the BIOS settings (see “I/O Device Configuration (Advanced Menu)” on page 5 - 10). For further information, please refer to the manual of the device you wish to connect.

Infrared Communication

The infrared transceiver operates on a "Line of Sight".

Make sure nothing is blocking the "Line of Sight" between your system’s transceiver and the destination's transceiver.
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices Windows control panel (see Figure 1 - 8 on page 1 - 13), or from the Sound Effect Manager icon in the taskbar/control panel (this will bring up the Realtek Audio Configuration menus). The volume may also be adjusted by means of the Fn + F5/F6 key combination.

![Realtek Audio Configuration Menus](image-url)

Figure 2 - 7
Realtek Audio Configuration Menus
8 Channel Sound Support

If you wish to configure your system for 8 channel sound support, then the following ports should be used as outputs.

- Side Speaker Out - Connect to S/PDIF Out
- Center/Subwoofer Speaker Out - Connect to Microphone In
- Front Speaker Out - Connect to Speaker/Headphone Out
- Rear Speaker Out - Connect to Line In

Figure 2 - 8 Channel Sound Support
Audio "DJ" CD Player

The built-in standalone audio CD player gives you direct hardware control for audio CDs/DVDs when the computer is shut down, but has a working power source.

1. Make sure that the computer is shut down (i.e. the operating system is not running) but you have a working power source (either battery or AC Power).
2. Press the Audio "DJ" power button.
3. Press the open button on your CD/DVD device (or press the stop button twice) and carefully place an audio CD onto the disc tray with label-side facing up (DVD drives will also play audio CDs).
4. Gently push the CD/DVD tray in until its lock "clicks" and you are ready to start.
5. The Audio Format Indicator will flash while data is being accessed and will then display the audio format of the CD/DVD (CD or MP3).
6. The LED will display the number of tracks.
7. Click the play/pause button to start the CD/DVD.
8. You can control the CD/DVD tracking and volume from the control panel.
9. Use the stop button to stop the disc, or press it twice to eject the disk.
10. The player can be turned off by pressing the power button again.

Disk Eject Warning

Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”. Stop the disk first then eject it, or press the stop button twice.
1. Audio "DJ" Power Button
2. Previous Track
3. Next Track
4. Shuffle (loop, in order, shuffle)
5. LED Display
6. Play/Pause
7. Stop (press twice to eject the CD/DVD)
8. Volume Down
9. Volume Up
10. Audio Format Indicator
11. Shuffle Mode Indicator
12. Track Indicator

**Note:** The time will be displayed on the LED Display if set in the BIOS (see “Display Time on LED (Advanced Menu > Advanced Chipset Control)” on page 5 - 10).
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Schemes
• System Power Options
• Configuring the Power Button
• Battery Information

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in Windows XP.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

(Note: All pictures used on the following pages are from the Windows XP OS.)
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components (see page C - 6).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 12).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 9.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Shutdown

Note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.
Power Management

Power Schemes

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Stand by** or **Hibernate** modes (see “**System Power Options**” on page 3 - 6).

**Figure 3 - 1**

**Power Schemes**
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office Desk* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.

*Windows* will use *Portable/Laptop* as the default scheme.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. This system features Stand by and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - Figure 3 - 2 on page 3 - 7).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Stand by Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

System Resume
The system can resume from Stand by mode by:
- Pressing the power button
- Pressing a key on the keyboard
- An alarm resume that is enabled and expires
- An incoming call received on the modem (if enabled)
- Network card activity (if enabled)

Figure 3 - 2
Enable Hibernation
Configuring the Power Button

The power button may be set to send the computer in to either Stand by or Hibernate mode. In Stand by mode, the LED will flash green. In Hibernate mode the LED will be off. If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

Sleep Button

You may also configure the Sleep/Resume key combination (Fn + F4) from the menu illustrated in Figure 3 - 3. In Windows this is referred to as the Sleep button.
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

**New Battery**

Always completely discharge, then fully charge, a new battery (see "Battery FAQ" on page 3 - 12 for instructions on how to do this).

**Battery Life**

Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. **Power Options** (you may set low battery **Alarms** and actions, and check the **Power Meter** from the **Power Options** control panel), and settings in the OS will help prolong the battery life if configured appropriately.

---

**Low Battery Warning**

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

---

**Figure 3 - 4**

Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 6 for information on the battery charge status, and to “Battery Information” on page 3 - 9 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms (unclick the tickboxes - see 3 - 9) and Schemes (change all the settings to Never - see page 3 - 4). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities. The following operating system is covered.

- *Windows XP Professional and Home Editions*
- *Windows XP Media Center Edition*

### System Software Installation with RAID Option

If you have included the RAID option in your purchase configuration and want to install a *Windows XP* operating system, prepare the following before beginning to install the OS:

- A USB floppy disk drive
- A Windows XP OS CD/DVD
- A formatted blank 3.5” 1.44MB floppy diskette
- The *Device Drivers & Utilities + User’s Manual CD-ROM*

See the “RAID Setup” on page 7 - 21 for instructions on creating the RAID and installing the OS. You can then install the appropriate drivers and utilities (from page 4 - 9).
What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM contains the drivers and utilities necessary for the proper operation of the computer. The drivers for all the modules (WLAN, Bluetooth, PC Camera and TV Tuner) are on the separate CD-ROMs supplied. Table 4 - 1, on page 4 - 7 lists what you need to install manually according to your choice of the operating system, and it is very important that the drivers are installed in the order indicated.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth, TV Tuner, and PC Camera modules are provided in “Modules” on page 7 - 1. Make sure that the drivers are installed in the order indicated in Table 4 - 1, on page 4 - 7.
Navigate (Browse..) to D:

You will notice that many of the instructions for driver installation require you to "Navigate (Browse) to D:”. We assume that you will install all drivers and utilities from the built-in CD device and it is assigned to "Drive D:". In addition, all file extensions can be seen in this case "D:" is the drive specified for your CD device. Not all computers are setup the same way, and some computers have the CD listed under a different drive letter - e.g. if you have two hard drives (or hard disk partitions) one may be designated as “Drive C:" and the other as “Drive D:". In this case the CD device may be designated as “Drive E:" - Please make sure you are actually navigating to the correct drive letter for the CD device.

When you click the Browse (button) after clicking Run in the Start menu you will see the “Look in:" dialog box at the top of the Browse window. Click the scroll button to navigate to My Computer to display the devices and drive letters.

Figure 4 - 1 - Navigate (Browse..) to..
**Service Packs**

Check the warnings on the following pages regarding installation of the appropriate **Service Pack** for your *Windows* OS. If you are unsure of the Service Pack currently installed see below. Make sure you have installed the appropriate Service Pack **before** installing all the drivers.

---

**Windows XP Service Pack 2**

Make sure you install *Windows XP Service Pack 2* (or a Windows XP version which includes Service Pack 2) **before installing any drivers**. Service Pack 2 includes support for **USB 2.0**.

If you have **upgraded** the system by installing **Service Pack 2** (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:

1. Click **Start** (menu), point to **Settings** and click **Control Panel** (or click **Control Panel**).
2. Double-click **System** (icon); **System** (icon) is in **Performance and Maintenance** (category).
3. Click the **Hardware** (tab) > **Device Manager** (button).
4. Click “+” next to **Other Devices** (if its sub-items are not shown).
5. Right-click **Universal Serial Bus (USB) Controller** and select **Uninstall > OK** (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.

---

**Service Pack Installed**

To see which **Service Pack** is currently installed on your computer go to the **General** tab of the **System** control panel. Right-click the **My Computer** icon on the desktop or in the **Start** menu and select **Properties**. The Service Pack currently installed on your system will be listed under the “**System:**” heading. (If no Service Pack information is listed, then no Service Pack is installed.)
Authorized Driver Message
If you receive a message telling you that the driver you are installing is not authorized (Digital Signature Not Found), just click Yes or Continue Anyway to ignore the message and continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file version conflict” message, please click Yes to choose to keep the existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the Notebook Driver Installation application will run automatically. If you want to install the driver manually see “Manual Driver Installation” on page 4 - 7.

1. Check the driver installation order from Table 4 - 1, on page 4 - 7 (the drivers must be installed in this order) which is the same as that listed in the driver installation screen menu.
2. Double-click to select the name of the driver you wish to install.
3. Follow the instructions as listed in this chapter.
4. Make a note of the drivers you have installed.
5. If a restart is required after installing a driver, you will usually need to click the “Yes/Finish” button when prompted to restart the computer.
6. To get back to the Driver Installation screen click Start (menu) > Run... and navigate (Browse..) to D:\autodr3p.exe and click OK.
   OR
   Double-click the My Computer icon, and then double-click the CD icon.

Figure 4 - 2
Driver Installation Screen
Manual Driver Installation

If you wish to install the drivers manually, click the Exit button to quit the Notebook Driver Installation application, then follow the manual installation procedure for each driver. The manual installation procedure begins with instructions on how to browse to the executable file; “Click Start (menu) > Run..”.

Operating System Installation Warning

If you are installing an operating system (e.g. Windows XP), and have a 10-in-1 Card Reader present, make sure to set the Card Reader option in the BIOS to “Disabled”.

See “Card Reader: (Advanced Menu > Advanced Chipset Control)” on page 5 - 10.
Drivers & Utilities

Windows XP

**Driver Installation Procedure**

This section covers driver and utility installation instructions for *Windows XP Home & Professional*. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM* and click the appropriate driver name from the *NoteBook Driver Installation menu* and follow the instructions to install the driver, or **Click Start** and navigate (**Browse..**) to follow the manual setup instructions.

**New Hardware Found**

If you see the message “**New Hardware Found**” (**Found New Hardware Wizard**) during the installation procedure (**other than when outlined in the driver install procedure**), click **Cancel** to close the window, and follow the installation procedure.

---

**Windows XP Service Pack 2**

Make sure you install *Windows XP Service Pack 2* (or a Windows XP version which includes Service Pack 2) **before installing any drivers**. Service Pack 2 includes support for **USB 2.0**.

If you have **upgraded** the system by installing **Service Pack 2** (i.e. your Windows XP version does not include Service Pack 2) then follow the instructions in **“Windows XP Service Pack 2” on page 4 - 4**.
Drivers & Utilities

Chipset
1. Double-click **Chipset**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to **D:\Drivers\00CHIPSET\Setup.exe** and click **OK**.
2. Click **Next > Yes > Next > Next**.
3. Click **OK** to restart the computer.

RAID
1. Double-click **RAID**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to **D:\Drivers\01RAID\SETUP.EXE** and click **OK**.
2. Click **Next**.
3. Click the button to accept the license agreement, then click **Next**.
4. Click **Next > Next > Next**.
5. Click **Finish** to restart the computer.
6. See **“RAID Setup” on page 7 - 21** for setup instructions.
Drivers & Utilities

**AMD Processor**

1. Double-click **AMD**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to
   D:\Drivers\02AMD\setup.exe and click **OK**.
2. Click **Next > Yes > Next > Next**.
3. Click the button "**Yes, I want to restart the computer now.**", and click **Finish**.

**Video (VGA)**

1. Double-click **VGA**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to
   D:\Drivers\03VGA\NVIDIA\setup.exe and click **OK**.
2. Click **Next**.
3. Click **Finish** to restart the computer.

**Audio**

1. Double-click **Audio**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to
   D:\Drivers\04AUDIO\setup.exe and click **OK**.
2. Click **Next**.
3. Click **Finish** to restart the computer.
Modem
1. Double-click **Modem**.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to (one of the following)
   D:\Drivers\05MODEM\Setup.exe and click **OK**.
2. Click **OK > OK**.
3. Click **Yes** to restart the computer.
4. The modem is now ready for configuration.

   **Modem Country Selection**
   Be sure to check if the modem country selection is appropriate for you (**Control Panel** > **Phone and Modem Options**).

LAN
1. Double-click **Lan**.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to
   D:\Drivers\06LAN\Setup.exe and click **OK**.
2. Click **Next**.
3. Click **Finish**.
4. The network settings can now be configured.
Drivers & Utilities

AP-Key Buttons
1. Double-click AP-key.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\07AP-Key\AKSETUP.exe and click OK.
2. Click Next.
3. Click Finish to restart your computer.

TouchPad
1. Double-click Touchpad.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to D:\Drivers\08TOUCHPAD\Setup.exe and click OK.
2. Click Next > Next > Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart your computer.
4. You may then configure your TouchPad as outlined in “TouchPad and Buttons/Mouse” on page 2 - 8.
<table>
<thead>
<tr>
<th>Module Drivers</th>
<th>TV Tuner</th>
<th>PC Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the following pages for the driver installation procedures for any modules included in your purchase option.</td>
<td>See the install procedure in “Installing the AverTV Utility Software” and “Installing the Cyberlink PowerDVD 6 Software” on page 7 - 14.</td>
<td>See the install procedure in “PC Camera Driver Installation” on page 7 - 16.</td>
</tr>
<tr>
<td>Wireless LAN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>See the install procedure in “Intel WLAN Driver Installation” on page 7 - 4 or “Ralink 6833 WLAN Driver Installation” on page 7 - 5.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WLAN &amp; Bluetooth Combo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>See the install procedure in “MSI 6855B WLAN Driver Installation” on page 7 - 8 and “Bluetooth Driver Installation” on page 7 - 11.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The **POST** (Power-On Self Test)

**Configuration:** The **Setup** utility
If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in **Setup**. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

**Warning:** Incorrect settings can cause your system to malfunction. To correct mistakes, return to **Setup** and restore the **Setup Defaults** with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The **Phoenix Setup** program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

**Entering Setup**

To enter **Setup**, turn on the computer and press **F2** during the **POST**. The prompt (**Press F2 to Enter Setup**) seen in **Figure 5 - 1** on page **5 - 2** is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed **F2** too quickly) just press **F2** again.

If the computer is already on, reboot using the **Ctrl + Alt + Delete** combination and then hold down **F2** when prompted. The **Setup** main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
**IDE Channel 0/1/2/3 Master/Slave (Main Menu)**
Pressing **Enter** here opens the sub-menu to show the configuration of hard disks and CD/DVD device(s) on the computer’s IDE Channels. Use the **Auto** (Type:) setting to have the items configured automatically for you.

**System/Extended Memory: (Main Menu)**
This item contain information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

The **Main** menu also contains information on your video card and video BIOS version.
Advanced Chipset Control (Advanced Menu)

Pressing **Enter** here will allow you to select options for Advanced Chipset features (see Figure 5 - 4).
**SATA RAID Enable (Advanced Menu > Advanced Chipset Control)**
Enable/Disable SATA RAID mode from this menu (see “RAID Setup” on page 7-21).

![PhoenixBIOS Setup Utility](image)

- **SATA RAID Enable**: [Enabled]
- **CPU FAN Speed**: [Auto]
- **Card Reader**: [Enabled]
- **Display Time on LED**: [Enabled]

Enable SATA RAID function

**CPU FAN Speed (Advanced Menu > Advanced Chipset Control)**
Use this menu to adjust the CPU fan speed in order to save power. This item is set to “Auto” by default.

**Operating System Installation Warning**
If you are installing an operating system (e.g. Windows XP), and have a 10-in-1 Card Reader present, make sure to set the Card Reader option in the BIOS to “Disabled”.

**Figure 5 - 4**
Advanced Chipset Control Menu
Card Reader: (Advanced Menu > Advanced Chipset Control)
This option allows you to enable/disable support for the 10-in-1 Card Reader, and is "Enabled" by default. However if you are installing an operating system (e.g. Windows XP) it is recommended that you disable the card reader, as otherwise the card reader slots will automatically be defined as drives “C:” through “F:” (your hard disk drive will then be defined as drive “G:” etc.). If you set this option to “Disabled” in order to install the operating system, don’t forget to reset the option to “Enabled” after you have installed the operating system.

Display Time on LED (Advanced Menu > Advanced Chipset Control)
This option allows you to toggle the time display on the Audio "DJ" LED display.

I/O Device Configuration (Advanced Menu)
The sub-menus under this item include options to configure the Serial port A (Serial Mouse), Serial port B (Infrared) and Parallel (Printer) port. These can be left to the default settings, however you may wish to use certain devices that require settings to be adjusted accordingly. Check the documentation for any such devices to see what settings are required.
Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

Boot Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (or POST screen - see “The Power-On Self Test (POST)” on page 5 - 2).

Power On Boot Beep (Advanced Menu)
Use this menu to enable/disable the single beep sound at the end of the POST. This item is “Disabled” by default.
**Security Menu**

*Figure 5 - 5 Security Menu*

The changes you make here affect the access to the **Setup** utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.

---

### Security Menu

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Security</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor Password Is:</td>
<td>Clear</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Supervisor Password</td>
<td>Enter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password on boot:</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Set Supervisor Password (Security Menu)**

You can set a password for access to the **Setup** utility. This will not affect access to the computer OS, (only the **Setup** utility) unless you choose to set a **Password on Boot** (see over).
**Password on boot: (Security Menu)**
Specify whether or not a password (supervisor or user password) should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

**Note:** To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

---

**Password Warning**
If you set a boot password (Password on boot is “Enabled”), **NEVER** forget your password.

The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
When you turn the computer on it will look for an operating system (e.g. *Windows XP*) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot priority order**. Item specific help on the right is available to help you move devices up and down the order.
Exit Menu

Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the System Memory (RAM)
• Upgrading the Optical (CD/DVD) Device(s)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
Upgrading The Computer

When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts. You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Loosen screws 1 - 3.
3. Release the battery, and lift the battery 4 out of the battery bay.

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive(s)

The hard disk drive(s) can be taken out to accommodate other 2.5" IDE hard disk drives with a height of 9.5mm (h) (see “Storage Options” on page C - 4). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 4.
3. Remove the bay cover 5.

HDD System Warning

New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.

Figure 6 - 2
HDD Bay Cover Removal
4. Release the cable 6 and lift the hard disk assembly 7 up out of the computer.
5. Remove screws 8 - 15 in order to separate the bracket from the hard disk(s), and disconnect the cable 16 (see sidebar).
6. Reverse the process to install a new hard disk(s).

---

**Hard Disk Cable**

The computer supports both serial (SATA) and parallel (PATA) hard disks. Make sure you use the appropriate cable 16 for the particular hard disk(s) you use.

Only serial (SATA) hard disks (pictured) support a RAID configuration.
Upgrading the System Memory (RAM)

The computer has **two** memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) **DDR** type memory modules (see “Memory” on page C - 3). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn **off** the computer, and turn it over and remove the battery.
2. Locate the memory (RAM) bay cover and remove screws 1 - 4, and carefully (the fan cable will still be attached) lift off the bay cover 5.

*Figure 6 - 4
RAM Cover Removal*
3. Gently pull the two release latches (6 & 7) on the sides of the memory socket in the direction indicated by the arrows in Figure 6 - 5.

4. The RAM module 8 will pop-up, and you can remove it.
5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket (if you are installing only one RAM module, then it must be inserted into the lower socket only).
7. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.
8. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.
9. Replace the cover and screws (see Figure 6 - 4).
10. Restart the computer to allow the BIOS will register the new memory configuration as it starts up.

Contact Warning

Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.
Upgrading the Optical (CD/DVD) Device(s)

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 4, and remove the bay cover.
3. Remove screw 5 and use the screwdriver to push the optical device(s) out of the computer at point 6.

Figure 6-6
Removing the CD/DVD Device(s)
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- Mini-PCI Wireless LAN Module
- Bluetooth/WLAN Combo Module
- Mini-PCI TV Tuner Module
- PC Camera
- RAID Setup
The Wireless LAN & Bluetooth Modules

If your purchase option includes the any of the Wireless LAN modules and/or Bluetooth and Wireless LAN combination module, follow the information on the following pages for instructions on installing the driver. Pay careful attention to the warnings concerning the use of wireless modules aboard aircraft, and the instructions on enabling/disabling power to the modules.

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Power Toggle for the Wireless LAN and Bluetooth Modules
You will need to enable power to the modules by using the following key combinations:
Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle
When the Wireless LAN module is powered on, the LED will be green.
When the Bluetooth module is powered on, the LED will be orange.
Do not try to use the Wireless LAN module and the Bluetooth module at the same time, as this may cause a communication conflict.
Mini-PCI Wireless LAN Module

Before installing the Wireless LAN driver, make sure that the optional WLAN module is on (the \(\text{LED}\) will be green).

Use the WLAN module key combination \(\text{Fn} + \text{F11}\) to toggle power to the WLAN module. Make sure you install the drivers in the order indicated in \(\text{Table 4 - 1, on page 4 - 7}\).

You will be provided with the appropriate driver CD for your module. Insert the CD and follow the installation procedure.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Intel WLAN Driver Installation

1. Make sure the module is powered on, then insert the Intel PROSet/Wireless CD-ROM into the CD/DVD drive.
2. Click Install Software (button).
3. Click the button to accept the license and click Next > Next > OK.
4. Click OK to complete the installation.
5. You can configure the settings by going to the Intel (R) PROSet Wireless control panel (Start > Programs/All Programs > Intel PROSet Wireless), or by double-clicking the taskbar icon 📱.

Figure 7 - 1
Intel PROSet/Wireless User Guide
You can view the User Guides by inserting the Intel PROSet/Wireless CD-ROM and clicking View User Guides (button) as per Figure 7 - 1.
Ralink 6833 WLAN Driver Installation

1. Make sure the WLAN module is powered ON.
2. Insert the *Wireless LAN CD-ROM* into the CD/DVD drive.
3. The program will run automatically.
4. Click *Yes* to accept the license agreement.
5. Click *Finish*.
6. The *Ralink Wireless Utility* will run automatically.
7. Choose an access point from the *Site Survey* menu and click *Connect* (click *Rescan* to scan for any available access points).
8. Click *Help* (button) to access *RaLink Wireless Utility Help*.
9. You can access the *RaLink Wireless Utility* from the taskbar shortcut or *Start* menu (Start menu and point to *Programs/All Programs > Ralink Wireless > PCI > Ralink Wireless Utility*).
7 - 6 Mini-PCI Wireless LAN Module

**Figure 7 - 2**
Ralink WLAN Utility

Help Menu
Bluetooth/WLAN Combo Module

Before installing the Bluetooth/WLAN driver, make sure that the optional Bluetooth module/WLAN is on. Use the Bluetooth module key combination **Fn + F12** to toggle power to the Bluetooth module. Use the WLAN module key combination **Fn + F11** to toggle power to the WLAN module (the **LED** will be orange for Bluetooth and green for WLAN). Make sure you install the drivers in the order indicated in *Table 4-1, on page 4-7.*
Modules

**MSI 6855B WLAN Driver Installation**

1. Make sure the WLAN module is powered ON.
2. Insert the *Wireless LAN CD-ROM* into the CD/DVD drive.
3. The program will run automatically.
4. Click **Install Software** (button) and click **Next**.
5. Click the button to accept the license agreement, then click **Next**.
6. Click **Next > Install**.
7. Click **Finish**.
8. The network settings can now be configured.
9. Right-click the WLAN icon in the taskbar and click **View Available Wireless Networks** (*Windows* will manage the adapter by default, see the instructions overleaf for changing the WLAN control settings).
10. Select the network and click **Connect**, or click **Advanced** for further configuration options.
11. You can access the **WlanUtility** from the desktop shortcut or **Start** menu (**Start** menu and point to **Programs/All Programs > IEEE 802.11 Wireless LAN Software**).

The **User’s Manual** is on the *Wireless LAN CD-ROM*. Insert the into the CD/DVD drive, or double-click the CD icon, and click **Acrobat Reader** (button) to install the program (if you have not already done so) to read the **User’s Manual**.

---

7 - 8 Bluetooth/WLAN Combo Module
Changing the Control Setting in WinXP

The operating system is the default setting for wireless LAN control in Windows XP. It is recommended that you switch to use the WlanUtility to control your WLAN connection.

1. Right-click the WLAN icon in the taskbar and click **Open Network Connections**.
2. Click to select the **Wireless Network Connection** and then click **Change Settings of the connection** (see Figure 7-3 on page 7-10) or right-click it and scroll to select **Properties**.
3. Click **Wireless Networks** (tab).
4. Click to remove the tick in the tickbox **Use Windows to configure my wireless network settings**, then click **OK**.
5. Double-click the WLAN icon in the taskbar to begin using the WlanUtility to control the WLAN connection.
6. Select a network from **Available wireless networks**: “and click **Connect**.
Figure 7 - 3
Switching WLAN Controls

7 - 10 Bluetooth/WLAN Combo Module
Bluetooth Module

Before installing the Bluetooth driver, make sure that the **optional** Bluetooth module is on (the LED will be orange).

Use the Bluetooth module key combination **Fn + F12** to toggle power to the **WLAN module**. Make sure you install the drivers in the order indicated in *Table 4-1, on page 4-7*.

**Bluetooth Driver Installation**

1. Make sure the module is powered on, then insert the **Bluetooth CD-ROM** into the CD/DVD drive.
2. The program will run automatically.
3. Click **Application/Driver Installation** (button).
4. Choose the language you prefer and click **OK > Next**.
5. Click **Yes > Next** (click **Continue Anyway** if asked if you want to continue at any time).
6. Click **Finish** to restart the computer.
7. You can configure the settings by going to the **IVT Corporation BlueSoleil - Main Window** control panel (**Start > Programs/All Programs > IVT BlueSoleil > BlueSoleil**), or by clicking the taskbar icon.
8. The **Installation Guide**, **User Manual** and **FAQ Document** are all available from the installation window.

---

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are **OFF** if you are using the computer aboard aircraft.
User Guide

View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel. Click BlueSoleil User Guides in the Contents tab, and click to select the appropriate User Guide from the panel on the right.

Send To Bluetooth

Right-Click to select any file and scroll down to Send To... Bluetooth Device.

Figure 7-4
Bluetooth Control Panel & User Guides
Mini-PCI TV Tuner Module

If your purchase includes the optional AverMedia M103 Hybrid Mini-PCI TV Tuner (analog and digital) it will allow you to watch TV, play music CDs, video conference and capture still images and video on your PC.

You will need to install the driver and application software as per the instructions overleaf. The AverMedia M103 TV Tuner module comes with a remote control unit, and CDs containing the AverTV Utility software & Cyberlink PowerDVD software.

The CATV-In jack and S-Video-In jack will only be enabled when the TV Tuner module is installed. Make sure you install any software before connecting the coaxial cable to the TV antenna input.

TV Tuner Remote

The remote control unit provided with the optional TV Tuner will only function when the computer is powered from the AC/DC adapter, and not while the computer is powered by the internal battery.

Point the remote at the consumer IR transceiver to change channels etc.

Figure 7 - 5
TV Tuner Ports
1. CATV Jack
2. S-Video-In Jack
3. Consumer IR Transceiver
Installing the AverTV Utility Software
1. Insert the AverTV Utility CD-ROM into the CD/DVD drive.
2. Click TV Utility Software.
3. Click Yes > Next > Next (click Continue Anyway/Yes if asked to continue at any time).
4. Click Finish.
5. Run the program from the Start > Programs/All Programs > AVerTV 6.0 menu, and select the AverTV 6.0 program, or double-click the icon on the desktop.

Installing the Cyberlink PowerDVD 6 Software
1. Insert the Cyberlink PowerDVD CD-ROM into the CD/DVD drive.
2. Click Next > Yes > Next > ....... Next.
3. Click Finish.
4. Run the program from the Start > Programs/All Programs > CyberLink PowerDVD menu, and select the CyberLink PowerDVD program, or double-click the icon on the desktop.
5. Type in the CD-Key and click Activate > OK, then run the software again.
**Digital TV Broadcast Signal**

The antenna is the most crucial factor in receiving a clear Digital Terrestrial TV broadcast signal. The *passive* antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an *active* antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on Digital Terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.
PC Camera

If your purchase includes the optional PC Camera you will need to install the device driver for it as indicated on the following pages (make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 7).

PC Camera Driver Installation

1. Insert the PC Camera CD-ROM into the CD/DVD Drive.
2. The program will run automatically.
3. Click Next.
4. Click Finish > OK to restart the computer.
5. Run the EMAMCAP application software from the USB2.0 1.3M PC CAM item in the Start > Programs/All Programs menu (give the computer time to find the hardware).
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in Device volume (Volume tab).
3. Click Options and scroll down and click Properties.
4. Select Realtek AC97 Audio from the Mixer Device menu.
5. Click Recording (button).
6. Click Microphone (check box) if it is not checked, then click OK.
7. Make sure the Select (check box) in the Recording Control panel, under the Microphone section, is checked (boost the volume as high as it will go).
8. Close the window, then click OK.

Taking Still Pictures
You may take still pictures in the Windows XP operating system only.

Double-click the My Computer icon on the desktop, or go the Start menu and point to My Computer, then click it.

Double-click the USB2.0 1.3M PC CAM icon.

Click Take a new picture in the Camera Tasks box.
Figure 7-6
Audio Setup

7 - 18 PC Camera
EMAMCAP
The EMAMCAP video viewer can capture video files to .avi format, and is useful for basic general purpose video viewing and testing (a number of commercially available programs support advanced video capture features).

1. Run the EMAMCAP program from the Start > Programs/All Programs > USB2.0 1.3 PC Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name, size (see the sidebar - Pre-Allocating File Space) and location for the captured file.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video..., choose a file name and location, then click Open (you can view the file using the Windows Media Player).

Set Capture File
In the EMAMCAP program you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space
You may pre-allocate the file size for the capture file in the EMAMCAP program. You can choose to ignore this by clicking Cancel.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Eliminating Screen Flicker
If you find that the video screen in the EMAMCAP program is flickering, you can try to adjust the setting in the Lighting Selection options.

1. Run the EMAMCAP program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click Video Image (tab).
4. Select Florescent 50Hz, Florescent 60Hz or Incandescent in the Light dropdown.

![Figure 7 - 7 Video Image](image-url)
RAID Setup

If your purchase includes the RAID (Redundant Array of Independent Disks) option, then see the instructions on the following pages for an introduction to configuring your hard disk(s) in RAID mode. This will allow you to use your hard disks in combination with Striping (RAID 0) or Mirroring (RAID 1) for fault tolerance and performance. Configure the RAID as follows:

1. Setup the serial hard disks in the computer (this may have already been done for you, or see “Upgrading the Hard Disk Drive(s)” on page 6 - 4).
3. Enable the RAID option in the BIOS.
4. Create the array from the SATA RAID BIOS Utility.
5. Install the Windows XP operating system.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to increase performance. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to protect data. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>

Table 7 - 1
RAID Levels
RAID Mode Setup

1. Install two identical serial hard disk drives
2. Prepare a formatted blank 3.5” 1.44MB floppy diskette, and an external USB floppy disk drive.
3. Create a RAID Driver Diskette by using an operable computer to copy the drvdisk folder from the Device Drivers & Utilities + User’s Manual CD-ROM (Navigate/Browse.. to D:Drivers\Raid\drvdisk) to the blank floppy diskette.
4. Startup your computer and press <F2> to enter the BIOS (see “Advanced Menu” on page 5 - 8).
5. Go to the Advanced Chipset Control menu and set the “SATA RAID Enable:” item to Enabled.

Figure 7 - 8
Advanced Menu > Advanced Chipset Control (BIOS)
6. Select the CD-ROM/DVD-ROM as the first device in the "**Boot priority order**" by pressing the `<Shift>` and `<+>` keys to move the CD-ROM/DVD-ROM to the top of the order.

7. Make sure that the computer is connected to the AC power source, and press **F10** to save the changes, and exit the BIOS.

8. As the computer boots up you will see the screen below if no disk array is defined (press the **Tab** to enter the utility).

---

**Figure 7 - 9**
Boot Menu (BIOS)

**Figure 7 - 10**
VIA RAID BIOS Boot Screen
9. The **SATA RAID BIOS Utility** will then appear.

10. Select the options from the **Create Array** menu option.

11. Choose the disk drives from the **Select Disk Drives** menu, and press Enter to select the disk drives.

12. Select **Start Create Process**, and press Enter and **Y** to create the RAID.

13. Press **ESC** twice, and then press **Y** to exit the utility.

14. Insert the **Microsoft Windows OS CD** into the CD/DVD drive, and connect the external USB floppy disk drive to the notebook computer.

15. Press a key when you see the message *“Press any key to start up from the CD/Press any key to boot from CD”.*
16. Press the F6 key when you see the message “Press F6 if you need to install third party SCSI or RAID driver”.
17. When the Windows Setup menu appears, press the <S> key to "Specify Additional Device”.
18. Insert the RAID Driver Diskette into the external USB Floppy drive.
19. Press Enter to select the controller for your Windows XP operating system (see below).
20. The system will now read from the floppy disk drive and then return to the Windows Setup menu.
21. Press Enter to continue installing the operating system as normal (see your Windows documentation if you need help on installing the Windows OS).
22. Install the chipset driver as per the instructions in “Chipset” on page 4 - 9.
23. Install the RAID driver as per the instructions in “RAID” on page 4 - 9.
24. Double-click the VIA RAID Tool icon in the taskbar.
25. You can then further configure the disk array from the VIA RAID Tool application.
26. Click Create (button) to create the Striped array.
27. You will be prompted to reboot the system to enable the array.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 6) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Stand by mode by pressing the keys configured in your Power Management/Power Options (see “Configuring the Power Button” on page 3 - 8), the Fn + F4 key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see Table 1 - 4, on page 1 - 8).

- **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display (see Table 1 - 4, on page 1 - 8).

- **Boot Drive** - Make sure there are no floppy disks in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “Security Menu” on page 5 - 12).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Viruses

- Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

- Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
# Troubleshooting

## Problems & Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned the power on but it doesn’t work.</td>
<td><strong>Battery missing / incorrectly installed.</strong> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The Battery LED power indicator 😌, is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing battery power too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a Power Options scheme (see “Power Schemes” on page 3 - 4) check its settings. You may also be using a PC Card device that is drawing a lot of power.</td>
</tr>
<tr>
<td>Actual battery operating time is shorter than expected.</td>
<td><strong>The battery has not been fully discharged before being recharged.</strong> Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 9).  &lt;br&gt; <strong>Power Options have been disabled.</strong> Go to the Control Panel in Windows and re-enable the options.  &lt;br&gt; <strong>A peripheral device or PC Card is consuming a lot of power.</strong> Turn off the unused device to save power.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The computer feels too hot.</strong></td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this doesn't cool it down, put the system into <em>Hibernate</em> mode or turn it off for an hour. Make sure the computer isn't sitting on a thermal surface (see “Overheating” on page 1-9). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked.</td>
</tr>
<tr>
<td><strong>Nothing appears on screen.</strong></td>
<td>The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4 (see “Sleep Button” on page 3-8). The screen controls need to be adjusted. Toggle the screen control key combinations Fn + F8/F9 (see Table 1 - 4, on page 1 - 8). If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. The computer is set for a different display. Toggle the screen display key combination, Fn + F7 (see Table 1 - 4, on page 1 - 8). If an external monitor is connected, turn it on. The screen saver is activated. Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td><strong>No image appears on the external monitor I have plugged in and powered on.</strong></td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “What to Install” on page 4 - 2 for instructions on installing the driver, and see “NVIDIA Video Driver Controls” on page B - 1 for instructions on configuring the video driver.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Problem

### Possible Cause - Solution

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the boot password.</td>
<td><em>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</em></td>
</tr>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low. Check the volume control in the Windows taskbar, or use the key combination <code>Fn + F5</code> and <code>F6</code> (see “Audio Features” on page 2-10) to adjust.</em></td>
</tr>
<tr>
<td>The compact disc cannot be read.</td>
<td><em>The compact disc is dirty. Clean it with a CD-ROM cleaner kit.</em></td>
</tr>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2-3).</em></td>
</tr>
<tr>
<td>The DVD regional codes can no longer be changed.</td>
<td><em>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2-5.</em></td>
</tr>
</tbody>
</table>

### Password Warning

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Audio &quot;DJ&quot; CD Player will not turn on (nothing appears on the LED Display of the player).</td>
<td><em>The computer is turned ON</em> (see “Audio &quot;DJ&quot; CD Player” on page 2 - 12). Check your computer is not turned on (or running in a power saving mode), and if it is, then shut it down and toggle the ON/OFF switch on the Audio &quot;DJ&quot; Player.</td>
</tr>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td><em>If the LED [1] is lit, then Num Lock is turned ON</em> (see “LED Indicators” on page 1 - 6).</td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press a key on the keyboard, or press the sleep (\textbf{Fn} + \textbf{F4}) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the <em>Windows</em> Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 6). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
</tbody>
</table>

---

### Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However, special functions/hot-keys unique to the system's regular keyboard may not work.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wireless LAN/Bluetooth/ modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the LED indicator to see if the modules are on or off (see “LED Indicators” on page 1 - 6). If the LED indicator is off, then press the appropriate AP-Key button in order to enable the modules (see Table 1 - 3, on page 1 - 7).</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/ modules cannot be configured.</td>
<td><em>The driver(s) for the module(s) have not been installed.</em> Make sure you have installed the driver for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate module).</td>
</tr>
<tr>
<td>The PC Camera software displays a black screen when the EMAMCAP software is run.</td>
<td><em>The software is using the incorrect device.</em> If you have both the optional PC Camera and TV Tuner modules present, make sure you install the TV Tuner driver and application first. After installing the PC Camera driver you will need to select which device to use with the EMAMCAP program. Go to the Devices menu in the EMAMCAP program and select the USB2.0 1.3M PC CAM device. (see “PC Camera &amp; TV Tuner” on page 7 - 16).</td>
</tr>
</tbody>
</table>
Troubleshooting
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built-In Microphone</td>
<td>The built-in microphone allows you to record on your computer.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>Serial Port</td>
<td>Connect a serial type mouse to this port.</td>
</tr>
<tr>
<td>Parallel Port</td>
<td>Connect a parallel type printer to this port. The port supports ECP (Extended Capabilities Port) and EPP (Enhanced Parallel Port) 1.7/1.9 modes.</td>
</tr>
<tr>
<td>DVI-Out Port</td>
<td>The DVI-Out (Digital Visual Interface) Port allows you to connect an external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD and external monitor/FPD (see “Display Devices &amp; Options” on page 1 - 14). If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA.</td>
</tr>
<tr>
<td>PS/2 Port</td>
<td>Connect an external PS/2 type mouse or keyboard to this port. You can use a “Y” splitter if you want to attach both.</td>
</tr>
</tbody>
</table>
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ-11 Phone Jack</td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.</td>
</tr>
<tr>
<td><strong>Note</strong>: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
<td></td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions.</td>
</tr>
<tr>
<td><strong>Note</strong>: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
<td></td>
</tr>
<tr>
<td>CATV-In Jack</td>
<td>Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in your purchase.</td>
</tr>
<tr>
<td>CATV</td>
<td></td>
</tr>
<tr>
<td>S-Video-In Jack</td>
<td>The S-Video-In jack allows video input to the computer if you have included the optional Mini-PCI TV Tuner in your purchase.</td>
</tr>
<tr>
<td>S-Video-Out Jack</td>
<td>Connect your television to your computer and view DVDs, VCDs or anything else your computer can display. You will need an S-Video cable to make the connection. Enable this port from the video driver controls.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mini-IEEE 1394a Ports</strong></td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
<tr>
<td><strong>IEEE 1394</strong></td>
<td>The Mini-IEEE 1394a ports only support <strong>SELF POWERED</strong> IEEE 1394 devices.</td>
</tr>
<tr>
<td><strong>Line-In Jack</strong></td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers.</td>
</tr>
<tr>
<td><strong>S/PDIF-Out Jack</strong></td>
<td>This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td><strong>Microphone-In Jack</strong></td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td><strong>Headphone-Out Jack</strong></td>
<td>Headphones or speakers may be connected through this jack. <strong>Note</strong>: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td><strong>Security Lock Slot</strong></td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
</tbody>
</table>
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 14.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 7.

1. Double-click VGA from the Notebook Driver Installation menu. OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\04VGA\NVIDIA\setup.exe and click OK.
2. To continue click Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart the computer.

Note: Due to the manufacturer's release schedule, some of the video cards listed in this Appendix may not have been available at the time of going to press. Check with your service center for the latest details on video cards supported.

Video Card Options

This computer features different PCI Express video card options (see “Video Card Options” on page C - 3).

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Controls

NVIDIA Display Properties

More advanced video configuration options are provided in the NVIDIA Display Properties control panel tab.

1. Open the Display Properties (see “Video Features” on page 1 - 14) control panel.
2. Click Advanced (button).
3. Click GeForce Go/Quadro FX Go (tab).
4. Click Additional Properties (or click the icon ) to make any video adjustments.

Figure B - 1
Enable Taskbar Icon

Taskbar Icon

Click the NVIDIA taskbar icon then click NVIDIA Display > Laptop Display to bring up the GeForce Go/Quadro FX Go control panel.

If you cannot see the tray icon, go to the GeForce Go/Quadro FX Go control panel tab and select the Tools item from the Additional Properties menu. Click the tickbox “Enable taskbar icon”, and apply the settings.

GeForce Go/Quadro FX Go Control Panel

To access the GeForce Go/Quadro FX Go control panel from the desktop:

Right-click the desktop, then point to NVIDIA Display and click Laptop Display.

B - 2 NVIDIA Display Properties
Additional Properties
The items listed in the Additional Properties window allow you to configure your display(s). If the items do not display you can either click the Additional Properties button, or click the icon .

Some screen examples are shown on the following page.
You may make changes to the Display Settings, Color Correction, Video Overlay, Resolutions, Refresh Rates and Screen Rotation by clicking the appropriate tab and adjusting the setting.

Figure B - 3
Screen Examples

Help Menus
Right-click on many of the items in the tabs to bring up the “What’s This?” button.

Click the “What’s This?” button to bring up the help menu.

Right-click on a control panel item to bring up a Help menu (see sidebar).
NVIDIA nView Desktop Manager

The nView Desktop Manager allows quick access to control panels for features such as Desktop Management, Profiles, Hot Keys etc. The Control panel may be accessed as follows.

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click NVIDIA nView Desktop Manager (icon) - Click "Switch to Classic View" from the left of the menu if you are in Category View.

Click the Enable button to display the Desktop Management options menu.

The Display Wizard helps you to quickly configure any attached displays.

You can view the nView Desktop Manager control panels from the Additional Properties window.

Select Additional Properties from the GeForce Go/Quadro FX Go control panel. Click the Desktop Management window and click the Enable button to display the options.

**Figure B - 4**
Desktop Manager Control Panel
Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display or TV as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the DVI-Out Port (may require DVI to VGA converter).
3. A flat panel display connected to the DVI-Out Port (may require DVI to VGA converter).
4. A TV connected to the S-Video-Out jack.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.
Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the DVI-Out Port at the rear of the computer.

1. Attach your external monitor to the DVI-Out Port (or TV to the S-Video-Out jack), and turn it on.
2. Go to Additional Properties in the GeForce Go/Quadro FX Go Properties control panel tab (see “NVIDIA Display Properties” on page B - 2).
3. Select nView Display Settings.
4. Select the display mode from the nView Display Mode drop box.
5. Select Apply.
6. Click Yes to confirm the settings.

**Function Key Combination**

You can use the **Fn + F7** key combination to toggle through the display options:
- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

**Device Settings**

Click the display icon to select it, then click the **Device Settings** button to make any adjustments for the selected display (including Screen Resolutions & Refresh Rates).

**Figure B - 5 nView Display Settings**
7. Select the display option from the **Primary Display/Secondary Display** dropbox. If you have a TV and external monitor/flat panel display attached you will have a number of available options (see sidebar). Select and **Apply** the appropriate option.

8. Click the monitor icon to select it, then click the **Device Settings** button to make any adjustments for the selected display (including **Screen Resolutions & Refresh Rates**).

9. Click **Apply** to confirm any setting changes.
Display Modes

**Single Display Mode**
Only one of your displays is used.

**Clone Mode**
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content and each display device can be configured independently.

**Dualview Mode**
Dualview Mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When Dualview is enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.

Display Wizard
Use the Display Wizard in the Desktop Management window to quickly setup and configure any attached displays (see Figure B - B - 4 on page B - 5).
NVIDIA Video Driver Controls

Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an S-Video cable from the TV to the S-Video-Out jack on the left side of the computer (see “System Map: Left View” on page 1 - 10).

You will need to enable the TV display from the nView Display Settings tab (see “Attaching Other Displays” on page B - 7). The TV will appear as a display option (select the display option from the Primary Display/ Secondary Display dropdown) when attached to the S-Video-Out jack.

Detect Displays

To get a full range of options from the Device Settings menu, click the Detect Displays button. Click to select the TV icon, then click the Device Settings button.

Figure B - 7
TV Settings
Set the **TV format** from the **Select TV Format menu**. The **Advanced** option (in **Dualview** mode) at the bottom of the **Select TV Format** menu allows you to select TV format by country if you are unsure of your TV format.

**Device Adjustments** (**Device Settings** menu) allows you to make changes to the **TV output**.
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed or updated due to the manufacturer’s release schedule. Check with your service center for details.
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor Types</strong></td>
<td><strong>AMD Athlon™ 64 FX-53 (89W), FX-55 (104W) 939-pin OuPGA Package</strong></td>
</tr>
<tr>
<td></td>
<td>(µ0.13) 0.13 Micron Silicon-On-Insulator (SOI) Process Technology, 1MB On-Die L2 Cache Models <strong>2400MHz/ 2600MHz</strong></td>
</tr>
<tr>
<td></td>
<td><strong>AMD Athlon™ 64 (67 - 85.3 W) 939-pin OuPGA Package</strong></td>
</tr>
<tr>
<td></td>
<td>(µ0.13) 0.13 Micron Silicon-On-Insulator (SOI) Process Technology, 512KB On-Die L2 Cache Models <strong>3000+/ 3200+/ 3400+/ 3500+/ 3800+</strong></td>
</tr>
<tr>
<td></td>
<td>(µ0.13) 0.13 Micron Silicon-On-Insulator (SOI) Process Technology, 1MB On-Die L2 Cache Models <strong>3700+/ 4000+</strong></td>
</tr>
<tr>
<td></td>
<td><strong>AMD Athlon™ 64 X2 (35 - 110 W) 939-pin OuPGA Package</strong></td>
</tr>
<tr>
<td></td>
<td>(µ0.09) 0.09 Micron Silicon-On-Insulator (SOI) Process Technology, 512KB On-Die L2 Cache Models <strong>3800+/ 4200+/ 4600+</strong></td>
</tr>
<tr>
<td></td>
<td><strong>AMD Athlon™ 64 X2 (35 - 110 W) 939-pin OuPGA Package</strong></td>
</tr>
<tr>
<td></td>
<td>(µ0.09) 0.09 Micron Silicon-On-Insulator (SOI) Process Technology, 1MB On-Die L2 Cache Models <strong>4400+/ 4800+</strong></td>
</tr>
<tr>
<td><strong>Core Logic</strong></td>
<td>VIA K8T890CE + VT8237R Chipset</td>
</tr>
<tr>
<td><strong>LCD</strong></td>
<td>17&quot; WXGA (1440 * 900) / WSXGA+ (1680 * 1050) / WUXGA (1920 * 1200) TFT LCD</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Security (Kensington® Type) Lock Slot BIOS Password</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Memory</td>
<td>Two 64-bit wide DDR Data Channels</td>
</tr>
<tr>
<td></td>
<td>Two 200 Pin DDR SODIMM Sockets Supporting DDR 400MHz</td>
</tr>
<tr>
<td></td>
<td>Expandable up to 2GB (Compatible with 1024MB, 512MB, 256MB DDR 400MHz Modules)</td>
</tr>
<tr>
<td>BIOS</td>
<td>One 512KB Flash ROM</td>
</tr>
<tr>
<td></td>
<td>Phoenix BIOS</td>
</tr>
<tr>
<td>Video Card Options</td>
<td>NVIDIA GeForce Go 6800</td>
</tr>
<tr>
<td></td>
<td>NV42M High Performance Graphic Chip</td>
</tr>
<tr>
<td></td>
<td>256MB DDR OR DDR-III (DDR3) Video RAM On Board</td>
</tr>
<tr>
<td></td>
<td>256 bit Memory Interface</td>
</tr>
<tr>
<td></td>
<td>PCI Express * 16</td>
</tr>
<tr>
<td></td>
<td>Fully DirectX® 9 Support</td>
</tr>
<tr>
<td></td>
<td>Modular Design</td>
</tr>
<tr>
<td></td>
<td>NVIDIA Quadro FX Go 1400</td>
</tr>
<tr>
<td></td>
<td>NV42GLM Ultra High Performance Graphic Chip</td>
</tr>
<tr>
<td></td>
<td>256MB DDR-III (DDR3) Video RAM On Board</td>
</tr>
<tr>
<td></td>
<td>256 bit Memory Interface</td>
</tr>
<tr>
<td></td>
<td>PCI Express * 16</td>
</tr>
<tr>
<td></td>
<td>OpenGL Support</td>
</tr>
<tr>
<td></td>
<td>Fully DirectX® 9 Support</td>
</tr>
<tr>
<td></td>
<td>Modular Design</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce Go 6800 Ultra</td>
</tr>
<tr>
<td></td>
<td>NV42M Ultra - Ultra High Performance Graphic Chip</td>
</tr>
<tr>
<td></td>
<td>256MB DDR-III (DDR3) Video RAM On Board</td>
</tr>
<tr>
<td></td>
<td>256 bit Memory Interface</td>
</tr>
<tr>
<td></td>
<td>PCI Express * 16</td>
</tr>
<tr>
<td></td>
<td>Fully DirectX® 9 Support</td>
</tr>
<tr>
<td></td>
<td>Modular Design</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
</table>
| **Storage Options**      | One External USB 1.44Mb Floppy Disk Drive  
One Changeable Primary 2.5" 9.5mm (h) **Serial (SATA)** or **Parallel (PATA)** Hard Disk Drive  
One Changeable Secondary 2.5" 9.5mm (h) Hard Disk Drive (**RAID Option in SATA Configuration**  
  - Supports **Serial (SATA)** and **Parallel (PATA)** HDDs  
  - RAID 0, RAID 1, HDD Fault Tolerance System in **SATA Configuration**  
One Changeable Primary Optical Device Bay - 12.7 mm (h) for Optical CD/DVD Device Drive Options (see “**Optional**” on page C - 6)  
One Changeable Secondary Optical Device Bay - 12.7 mm (h) for Optical CD/DVD Device Drive Options (see “**Optional**” on page C - 6) |
| **Audio**                | AC '97 Compliant Interface  
**SRS(W) SRS WOW** Surround Sound Technology inside  
3D Stereo Enhanced Sound System  
Virtual 8-Channel Sound System  
Compatible with Sound-Blaster PRO™  
  - S/PDIF Digital Output (5.1 CH)  
  - Built-In Microphone  
  - 4 * Built-In Speakers  
  - Built-In Sub Woofer  
  - Built-In Audio "DJ" Console for Music CD (MP3 Format Compatible) |
| **Keyboard & Pointing Device** | Full Size Winkey Keyboard with Numeric Keypad  
  - Built-In TouchPad (Scroll Functionality Included) |
<p>| <strong>PCMCIA</strong>               | One Type II PCMCIA 3.3V/5V Socket |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Ports</strong></td>
<td>Four USB 2.0 Ports&lt;br&gt;Two Mini-IEEE1394a Ports&lt;br&gt;One S-Video-Out Jack for TV &amp; HDTV Output&lt;br&gt;One Serial Port&lt;br&gt;One Parallel Port (LPT1) Supporting ECP/EPP&lt;br&gt;One Infrared Transceiver (IrDA 1.1/FIR/SIR/ASKIR)&lt;br&gt;One DVI-Out Port&lt;br&gt;One PS/2 Port (Mouse/Keyboard)&lt;br&gt;One Headphone/Speaker-Out Jack&lt;br&gt;One Microphone-In Jack&lt;br&gt;One S/PDIF Out Jack&lt;br&gt;One RJ-11 Jack (Modem)&lt;br&gt;One RJ-45 Jack (Local Area Network)&lt;br&gt;One DC-In Jack&lt;br&gt;One Line-In Jack for Audio Input&lt;br&gt;One CATV-In Jack (Functions with Optional TV Tuner Module)&lt;br&gt;One Consumer Infrared Transceiver (Functions with Optional TV Tuner Module)&lt;br&gt;One S-Video-In Jack for Video Input (Functions with Optional TV Tuner Module)</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td>Infrared Transceiver&lt;br&gt;Infrared Transfer 1cm ~ 1M Operating Distance&lt;br&gt;115.2K bps SIR&lt;br&gt;4M bps FIR&lt;br&gt;IrDA 1.1 Compliant&lt;br&gt;10/100/1000 BASE-TX Fast Ethernet LAN on board&lt;br&gt;Integrated V.90/56K AC’97 Modem (V.92 Compliant)&lt;br&gt;802.11 b/g Mini-PCI Wireless LAN Module (Optional)&lt;br&gt;Bluetooth™ Class II V2.0 &amp; 802.11b/g Wireless LAN Mini-PCI interface Combo Module (Optional)&lt;br&gt;1.3M Pixel Video Camera Module (Optional)</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Embedded 10-in-1 Card Reader (MS/ MS Pro/ SD/ MMC/ CF/ Micro Drive/ SM/ MS Duo/ Mini SD/ MMC) <strong>Note:</strong> MS Duo/ Mini SD/ RS MMC Cards require a PC adapter</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 2.0&lt;br&gt;SUPPORTS Hibernate/Stand by Modes</td>
</tr>
</tbody>
</table>
| **Power**             | Full Range AC/DC Adapter – AC in 100~240V, 47~63Hz DC Output 20V, 11 A (220 Watts)  
                        | Easy Changeable 12-Cell Smart Lithium-Ion 6600mAH/14.8V Main Battery          |
| **Environmental Spec**| **Temperature**<br>Operating: 5°C ~ 35°C<br>Non-Operating: -20°C ~ 60°C         
                        | **Relative Humidity**<br>Operating: 20% ~ 80%<br>Non-Operating: 10% ~ 90%     |
| **Physical Dimensions & Weight** | 397mm (w) * 298mm (d) * 49.5mm (h)<br>5.80+3% kg with Battery              |
| **Optional**          | **Optical Drive Module Options:**<br>DVD/CD-RW Combo Drive Module<br>DVD-Dual Drive Module  
                        | 1.3M Pixel USB 2.0 Video Camera Module<br>Cyberlink PowerDVD 6.0 Player Software |
|                       | Hybrid (Analog & Digital) TV Tuner Module with Mini-PCI Interface              |
|                       | **WLAN/Bluetooth Module Options:**<br>Mini-PCI 802.11 b/g Wireless LAN Module  
                        | OR<br>Mini-PCI 802.11 b/g Wireless LAN + Bluetooth Combo Module                  |